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StepWatch™ 3.1 User’s Manual 
 © 2005-2008 
 
The StepWatch Step Activity Monitor (SAM) is a highly accurate ankle-worn 
ambulatory activity monitor, the size of a small pager. The StepWatch is attached to a 
person’s ankle by means of a band or cuff. The StepWatch works with a docking 
station and software that handles set-up, downloading, display, analysis, and many 
other functions. You will need a computer running either a Windows or Mac operating 
system. The Software is intuitive to use, and flexible. 
 
This manual is similar to but not identical to the Help available within the StepWatch 
software. Look there for further information. The material in this manual that 
specifically relates to the older StepWatch 2 system is in a lighter font. The rest of the 
material relates to the StepWatch 3 system or both. 
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I. General StepWatch™ Information and Care 
The StepWatch™ Step Activity Monitor (US Patent # 5,485,402) is a research and clinical 
tool for long-term assessment of ambulatory function in the real world. It is an ankle-
worn, microprocessor-controlled step counter, which unobtrusively measures how 
mobile a person is throughout daily life. Step counts can be recorded every minute for 
up to two months between downloads (one month for the StepWatch 2).  The true 
maximal recording time depends on the activity of the individual subject and, thus, 
can only be estimated. 
 
The StepWatch Activity Monitor detects steps for a wide variety of normal and 
abnormal gait styles and cadences ranging from a slow shuffle to a fast run. When 
properly used, accuracy typically exceeds 98%. You should expect accuracy at or near 
this level. Contact StepWatch technical support if your accuracy is notably lower (see 
“Contact Information” at the back of this manual.) 
 
A body of published research demonstrates that functional differences in gait activity 
can be clearly and objectively measured with the StepWatch in a wide range of human 
(and large animal) populations. A StepWatch Bibliography lists currently known 
publications using the StepWatch at www.orthocareinnovations.com. 
 
The StepWatch has been cleared by the US government FDA as a class II device, and is 
a powerful tool for assessment and description of ambulatory activity and 
quantification of outcomes. 
 

!"#$%&'#()#*+'#,*'-.%*/+#0%&12%&'#
The StepWatch 3 is designed to provide maintenance free performance for the life of 
the product. With proper use and care this is limited only by the battery life, which is 
typically 7 years under heavy use. 
 
Temperature extremes, particularly high temperatures will reduce battery life. Avoid 
leaving it in hot places such as the dashboard of a car in the hot sun. Maximum life will 
be achieved at room/body temperature. NEVER PLACE THE STEPWATCH IN ANY TYPE 
OF OVEN OR AUTOCLAVE as this could potentially cause the lithium battery to 
rupture or explode, possibly creating a hazard. 
 
The StepWatch is very durable and can tolerate rough handling and real-life wear and 
tear. Factory calibration of the sensor threshold is permanent and won't change in 
normal use. This is a sensitive instrument however, and should be treated with care 
and respect to maintain the highest possible accuracy. Extreme shock/vibration may 
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affect the sensor threshold, decreasing accuracy; examples include severe drops onto 
concrete and going through clothes washer/dryer. 
 
The StepWatch 3 is “waterproof”. This means swimming, wading, water aerobics; 
bathing and showering are all okay. Some water activities however may create 
extreme pressures that may be harmful. Among these are water skiing and scuba 
diving. The StepWatch was not designed to tolerate dishwashers, clothes washers, 
pressure washers, steam cleaners, high-pressure hose nozzles. 

3"#$4'%5657#%51#,%56*68657#

 The StepWatch is designed for multi-patient use. The StepWatch 3 monitor may be 
cleaned using a cloth dampened with mild soap and water or isopropyl alcohol. (PDI 
Super Sani-Cloth disposable germicidal wipes have been successfully tested on the 
StepWatch 3.) Strong detergents or solvents will damage the plastic and will void your 
warranty. Do not soak the StepWatch in any type of cleaner or solvent. Dry the 
StepWatch 3 at room temperature. NEVER PLACE THE STEPWATCH IN ANY TYPE OF 
OVEN OR AUTOCLAVE. 
 
The docking station is NOT waterproof. The StepWatch 3 Dock may be cleaned using a 
cloth dampened with mild soap and water or isopropyl alcohol. Strong detergents or 
solvents may damage the plastic and will void your warranty. The StepWatch 3 Dock is 
not waterproof. Do not soak the StepWatch Dock in any type of cleaner or solvent. Dry 
the StepWatch 3 Dock at room temperature. NEVER PLACE THE STEPWATCH DOCK IN 
ANY TYPE OF OVEN OR AUTOCLAVE. 
  
The StepWatch 3 straps and cuffs may be cleaned with mild soap and water. Dipping 
in isopropyl alcohol may sanitize them. Hand wash. Machine washing or drying may 
cause shrinkage and hasten deterioration of the elastic. In highly infectious situations 
consider them as single patient use items. 

9"#,'&:6/'#%51#;'-%6&#

 The StepWatch and the StepWatch Dock are not user-serviceable, Opening or 
tampering will void your warranty. They are factory repairable/refurbishable; contact 
Orthocare Innovations for details. 

<"#=6>-(>%4#

This symbol on the product or on its packaging indicates that this 
product must not be disposed of with your other household waste. 
Instead it is your responsibility to dispose of your waste equipment by 
handing it over to a designated collection point for the recycling of waste 
electronic and electrical equipment. 

The “Li” designation on the symbol indicates the presence of a lithium battery. 
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Lithium battery warning: Fire, explosion and burn hazard- do not short-
circuit, recharge, incinerate, expose to temperatures above 212F, 
disassemble, puncture or expose contents to water. Dispose of the 
battery properly. 

 

?"#,'**657#@-#*+'#,*'-.%*/+#A&(7&%B#%51#=%*%#C64'>#
Follow the instructions included with your order for installing the software on your 
computer. When you enter the serial number, all letters should be capital. All 0 are 
zero not the letter, and hyphens need to be entered as shown. At installation you can 
choose where on your computer to copy the StepWatch folder or directory, which 
contains the application and Library. The application will not run from the CD-ROM. 

3"#,*'-.%*/+#D6E&%&F#

Your StepWatch Library should always be in the same folder or directory as your 
StepWatch application. 
 
The StepWatch Library should contain two folders or directories - Program Files and 
Client Files. 
 
If you move your StepWatch application without moving your Library to the same 
folder or directory, the program will create a new library as soon as you run it. The 
preferences you had previously set up will not be recognized, any database 
information you had entered will not be available, and the program will not have 
access to the Help files. To correct this, you need to delete (throw away) the newly 
created library and place the old library into the same folder or directory as your 
StepWatch application. 

9"#A&(7&%B#C64'>#

The Program Files folder or directory exists within your StepWatch Library. This 
contains files essential to your program set-up and database. 
 
Never alter, delete or move your Program Files out of your StepWatch Library unless 
instructed to do so by Orthocare Innovations technical support personnel. 

<"#$46'5*#C64'>#

Your Client Files folder or directory exists within your StepWatch Library. We suggest 
that you store your StepWatch data files here. You may create sub-folders or sub-
directories within it for organizing your data files, add files to it, delete files from it, or 
change file names within it. If you want to keep your data files elsewhere, you can put 
an alias or shortcut to that location in your “Client Files” to facilitate quick navigation. 
We have included a directory called “Sample Data in your Client Files”. Within it is a 
demo data file for your interest. (See “Appendix B: Demo Date File” on page 41.) 
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$"#G>657#*+'#=(/H#
Be sure the StepWatch application is not running when you plug-in or unplug the 
dock. 
 
The StepWatch is placed on the dock face down (red side down) so that it fits into the 
indentation on the top of the dock. 
 
The System 3 Dock features lights that indicate its communications status: 

• Fading blue light  - The dock is plugged into the computer and has power. It is 
OK to unplug the dock when the light is like this but not during any other light 
condition. 

• Steady Green and Blue Lights  - The program is running and the correct USB 
port is selected in StepWatch program preferences so that the software can 
communicate with the dock. If the blue light is steady but the green light is not 
on, the correct port has not been selected. It is OK to take a StepWatch monitor 
off the dock is in t his state. 

• Steady Red and Blue Lights - There is a monitor on the dock and the dock is 
communicating with it. DO NOT REMOVE THE MONITOR. Wait until the green 
light comes on again before removing the monitor. 

• Flashing Red and Blue lights  - Error, see “Troubleshooting” on page 37. 
 
Replacing Batteries for Dock Versions earlier than Version 3 
Early versions of the docking station require battery power. Weak batteries can cause 
communications irregularities or failed communications. If you are suddenly 
experiencing such problems, replace the dock batteries: remove the 4 rubber feet on 
the bottom of the dock then use a Phillips screwdriver to remove the screws that hold 
the dock case together. Holding the dock upside down, carefully remove the bottom. 
You will see the 3 AA batteries. Take care not to drop the electronics card when replacing 
the batteries. The card is not fastened into the dock box. Do not over tighten the 
screws upon reassembly, or the threads may strip. 
 
The Version 3 docking station does not require battery power. It draws power from 
the USB connection. 
 

 #
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="#,'**657#A&')'&'5/'>#
Before you start to collect data, we recommend familiarizing yourself with each of the 
following preference options because they affect how the data is recorded, displayed and 
analyzed. You may change your preference settings by choosing “Preferences” from the “Edit” 
or “StepWatch” menus (depending on your operating system). Further information is available 
in StepWatch Help. 
 
Select whether you would like to use English or Metric units. This will affect both height 
measurements (inches or centimeters) and date formats (order of day and month, and 
characters separating day, month and year). The date format you choose should be the same 
as what is used by your computer operating system. (The European date style does not 
currently affect in all locations where dates appear.) 

3"#DI=#C4%>+'>#

The red LED on the StepWatch can be set to blink up to 100 times at the beginning of the 
recording session. It blinks each time a step is detected. You can use the LED flashes to quickly 
assess the appropriateness of your settings by watching your client walk and making sure the 
light blinks once for each step. Be sure your client is not also trying to look at the StepWatch 
because this creates a gait pattern that does not reflect typical movements. 
When using Advanced Programming, this preference is overridden by the number you 
specify on the programming screen. You may specify up to 255 LED blinks. 

9"#=%F>#*(#;'/(&1#

This preference sets the default running time for each monitoring session initiated with the 
regular programming mode. The programming window provides an option to change the 
setting for a particular monitoring session. Unless downloaded earlier, the StepWatch will 
always run at least this number of days, and may run slightly longer. You may want to set the 
StepWatch to record several days longer than your intended session so that if the client 
forgets to wear the monitor, you can extend the data collection session without your client 
having to return the monitor for re-programming. 

<"#A'&/'5*#J6B'#!/*6:'#

We recommend not changing this number from the default 35%. If you have extremely active 
or inactive subjects and are trying to record as long as possible, contact StepWatch technical 
support for further advice. 

K"#!@*(LIM/4@1'#

This function allows you to specify that days with relatively few or no steps are to be 
automatically excluded from analysis when your data are downloaded. The function only 
applies when data are first downloaded. Editing the time selection for the day in the “Edit 
Time” window may later include auto-excluded days. 
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N"#!/*6:6*F#D':'4#=')656*6(5>#

All step counts are based on the steps for one leg. 
 
The values you associate with Low and Medium Activity will be the upper limit for those 
categories. For example, 15 for Low means that all intervals with 1 - 15 steps/minute will be 
counted as Low Activity, and the Medium category will begin at 16 steps/minute. The High 
value does not set an upper limit for High Activity. 
Instead, this number controls the scale of the y-axis for plotting of the step data on your 
screen and for printing. 
 
We strongly recommend deciding on your Activity Level definitions once and leaving your 
preferences that way. This will allow you to directly compare results from different files and 
will reduce the potential for inconsistencies in your analyses and comparisons. 
 
Note on Activity Level Definitions: 
In our previous research with disabled populations, 15 and 30 for Low and Medium activity 
were effective limits. With those definitions, time spent at medium level activity tended to 
be a very strong marker of functional differences. 
 
In our normative data collection, we have favored 15 and 40 for the Low and Medium limits as 
these seemed to be natural break points in our aggregate distributions of activity intensity 
with normative subjects. These definitions have also been effective in distinguishing between 
the U.S. DHHS “Healthy People 2010” descriptions of "moderate" and "vigorous" activities. 
Further research is needed to inform us all on the most appropriate categorization schemes. 

O"#=6>-4%F#P-*6(5>#

 The “Draw Grid Lines for Step Rates” option controls whether horizontal step rate grid lines are 
drawn in the daily step plots on your screen and in printing. The “Display Activity Level as Color 
Bands” option controls whether the orange and yellow color bands for Low and Moderate 
activity are shown in the step plots on your screen and in printing. These color bands can be 
helpful references for visual inspection of your data, but they can also be misperceived. 
Remember that when the line representing any data point passes through and beyond a 
given band, that line is counted in the interval within which it peaks. When you change either 
of these settings, you will need to close and re-open any open files to see the effect. 

Q"#$(BB@56/%*6(5>#

Use the pop-up menu to specify the port into which you plugged the StepWatch dock. You 
may verify whether your selection is correct with the check dock function in the 
“Communications Test” of the Monitor menu or by looking to see that the green light is 
showing on the dock. 
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R"#C((*'&#S(*'#)(&#A&65*657#

On the “Preferences Printing” tab window you can customize a footer of up to 25 characters 
that will appear on pages printed from the StepWatch software. 

I"#A&(7&%BB657#*+'#T(56*(&#
There are two ways to program the StepWatch to record data: 

• Easy Start is accessed through the "Start Recording Activity" command in the Monitor 
menu. This option provides enough flexibility to set up the StepWatch appropriately 
for most clients and applications, while protecting you from unexpected results. You 
control the StepWatch settings indirectly by describing the gait characteristics of your 
client. We recommend you use this method unless you have an unusual application.  

 
To initiate “Easy Start” programming place the monitor face down on the dock and 
select “Start Recording Activity” from the “Monitor” menu. The software will read some 
information from the StepWatch, and the docking station will show a red light while it 
is communicating. DO NOT MOVE THE STEPWATCH WHILE THE RED LIGHT IS ON. This 
will take a few seconds. The Start StepWatch screen will then appear. Complete the 
client description. 

   
• Advanced Programming allows direct access to all the StepWatch settings and 

accommodates unusual uses. Use this option only if you have thoroughly familiarized 
yourself with the settings. Carefully study instructions for using the Advanced options 
and consult with Orthocare Innovations if you have questions.  

 
Prior to programming you may want to confirm that you have the preferences set as you wish 
them. (See “Setting Preferences on page 8.)   

3"#$46'5*#='>/&6-*6(5#

!"#$%&'()#

 This setting strongly affects the maximum rate at which the StepWatch can identify steps. In 
general, a person's height is inversely related to step rate, meaning a taller person will often 
have a slower step rate than someone shorter. 
If you do not know your client's height, give your best estimate. If you are off by a few inches, 
your accuracy will not be greatly affected. If you are estimating, it's better to guess shorter 
than to guess taller unless your client is prone to restless, fidgety movements. 

*"#+,&-.#/)%00&1'#

 A key to accurately identifying quick stepping activities is to distinguish overall walking or 
running speed from how quickly steps are being taken. Some activities, like running with long 
strides, involve traversing the ground rapidly without taking steps much more quickly than 
walking. Other activities, like vigorous dancing, involve moving the feet quickly without the 
body traversing the ground quickly. 
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It is also important to distinguish activities the client likes or knows how to do from those they 
are likely to undertake during the monitoring session. 
 
Indicating YES for the “Quick Stepping” setting has a fairly strong affect on the StepWatch 
performance; so if you are uncertain, choose NO. If you are in question about whether an 
activity qualifies, have the client "demonstrate their moves." 
 
Examples of quick stepping activities might be: 

• Running or jogging with a short and/or rapid stride 
• Vigorously playing sports such as basketball, soccer, volleyball, racquetball, tennis 
• Jumping rope (with more than one jump per rope cycle) 
• Romping energetically with a child or dog 
• Fast dancing 
• "Spinning" on a bicycle 
• High-impact aerobics 

-"#2!3.&1'#/0%%4#

Answering YES to “Quick Stepping” disables this command. 
 
Evaluating a person's normal walking speed relative to their height is likely an unfamiliar 
concept. The intent is to identify how quickly steps are being taken rather than the absolute 
speed at which a person traverses the ground. Comparing extremes in height helps illustrate 
the concept. Consider a small child, an average height mother, and a very tall father walking 
together at the same speed. If they are maintaining the mother's normal comfortable speed 
(and all are unimpaired), the child would be walking quite quickly relative to his height, and 
the father would be walking slowly relative to his height. 
 
Apply that concept to your client. For her height, is her normal walking speed slow, average, 
or fast? Most people will fall in the average category. 

4"#5!1'%#67#/0%%48#

Answering YES to “Quick Stepping” disables this command. 
 
This setting influences how broad a range of step rates the StepWatch will "expect". For most 
people, a moderate range is appropriate. Some clients, however, rarely change their walking 
speed because of habit, preference or (most commonly) physical limitations. 
It is more difficult to evaluate whether a person "regularly engages in both extremes". The 
following examples may help with the determination. Remember, a person must regularly 
exercise BOTH extremes to qualify. 
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Examples of the slow extreme might be: 

• Walking with a slow-moving elderly person 
• Walking with a young child 
• Meandering, window shopping 
• Slow pacing with a long stride 

The key is to identify whether the person regularly walks such that the leg is in the swinging 
phase for a long time. 
 
Examples of the fast extreme might be: 

• Fast walking (e.g. for exercise or within a job that requires moving quickly through 
large spaces) 

• Jogging or running with a fairly long stride (Note: if a person regularly runs with a 
short rapid stride, the Quick Stepping designation will be YES and the Range question 
will not be relevant) 

• Bicycling with a moderately fast cadence 
• Exercising on a Stair Master 

 
Note that bicycling appears to the StepWatch as walking. If a person regularly bicycles, it is 
helpful to get some idea of how quickly they pedal ("spinning" vs. moderate pedaling vs. slow 
pedaling.) 

%"#9%'#:6)&61#

From the time the client is in your presence, observe how they move. 
 
It is the motion at the leg and ankle that is most relevant since that is what the StepWatch will 
be sensing. Look at the motion of their leg/ankle rather than their whole gait. 

• Dynamic/fidgety: If your client is especially fidgety or tends toward quick, abrupt 
movements, use the "Fidgety and/or Dynamic" setting. Most children fall into this 
category. This setting may also be appropriate for people who are foot tappers, 
especially heel tappers. 

• Gentle/geriatric: If the client moves very slowly or gently, use the "Gentle and/or 
Geriatric" setting. This designation may also be appropriate for people who regularly 
undertake activities with subtle steps (usually in confined areas) if you are having 
trouble "capturing" those steps. Examples of those types of activities might be: 

- Working behind a counter or at a workbench 
- Dancing gently 
- Cooking in a small kitchen 

If you are unsure, program a monitor with the "Normal" setting and put it on the client. 
Have them demonstrate their movements. Watch whether the StepWatch light blinks 
when they take steps. If you are regularly missing steps, try using the "Gentle and/or 
Geriatric" setting. 
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Be careful about assuming a "Gentle and/or Geriatric" setting for persons who walk with 
a prosthesis, walker, cane or crutches. It is important to watch the motion of the leg in 
these cases. Often the leg swings forward fairly rapidly and a "Normal" setting is 
appropriate. "Normal" is also appropriate for older people whose ankle and leg motion 
is flexible. 

• Normal: Most people fall in the "normal" category. 

7"#5%-6;4&1'#<&=%#!14#>6)%8#

 Before initiating programming, you have the option of changing when the monitor will start 
and stop recording, and adding notes. Notes will be shown in the downloaded data file. 

9"#U56*6%*'#A&(7&%BB657#

 When you are satisfied with your description, click the Start button to initiate programming. 
Programming will take a few seconds. When programming is completed, the green light on 
the docking station will come on, and the software will tell you when recording will start. 

<"#V'&6)F#*+'#,'**657>#

 Once the programming is completed, you may wish to confirm the appropriateness of your 
settings by watching the LED blink one time per step as your subject walks at their normal 
speed. You may also have them walk at the “slowest pace they would normally walk” and the 
“quickest pace they would normally walk.” Your subject should not try to look at the monitor, 
as this will change their walking pattern. Watch to see that the StepWatch is not double 
blinking on slow steps, or missing fast steps. If you are walking with your subject, do not lead 
them or trail too far behind as this may influence their natural pace. If possible, stand still at 
the front, back or side and simply observe. 
 
Once a monitor has been programmed, do not double-check your settings by reading 
recorded activity or reading current settings. Both of these actions will stop the recording, 
and no data will be logged until the monitor is reprogrammed. 
 
If you have programmed a monitor to start recording but it has not yet begun, do not try to 
read recorded activity until it has had time to record at least one interval. 
 
If the StepWatch is not detecting steps as accurately as you wish and your attempts to 
adjust the Easy Start parameters does not help, review “Verify Cadence and Sensitivity 
Settings” in the  “Advanced Programming” section on page 32.  
 
The key to getting optimal results is balancing the Motion Sensitivity and the Cadence 
settings. If you have questions, contact Orthocare Innovations for advice. Virtually any gait 
style can be monitored accurately, but the difficult ones require more in depth 
understanding of how the settings relate to each other and respond particular gait styles. 
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C"#.'%&657#*+'#T(56*(&#

• The StepWatch 3 should be worn on the outside or inside (medial or lateral) aspect of 
either leg just above the anklebone. Wearing on the outside is usually preferred. 

• If you are using an older version of the monitor – the StepWatch 2 – place it on the 
outside of the right ankle or the inside of the left ankle for maximum accuracy. 

• The StepWatch may be worn over a sock for added comfort. Cotton lycra cuffs are 
available as an alternative to straps for attachment. Both come in various sizes. 

• Be sure the StepWatch is oriented RIGHT-SIDE-UP. It will not record step data when it is 
upside-down. Take some time to instruct your subject/patient about monitor 
orientation and to assure that they understand. This is also an opportune time to 
discuss where they will put the monitor when they take it off and what cues they will 
use to remember to put it on again. Being specific will facilitate compliance. 

• If the StepWatch 3 monitor is being worn during water activities, transferring it to a dry 
strap afterwards may be desirable. 

 
A sample instruction sheet for subjects/patients is available in the StepWatch Help file. 

UU"#W'5'&%4#=%*%#U5)(&B%*6(5#

!"#=(254(%1#X(@&#=%*%#
 Place the monitor face down on the dock and select “Read Recorded Activity” in the Monitor 
menu to download the data from your StepWatch. This will take a few seconds unless you 
have a very large file. 
 
Do not remove the monitor from the dock while it is communicating (while the red light on 
the dock is on). 
 
If you are unable to read a monitor see “Troubleshooting” on page 37, and the program Help 
files within the software program. 
Prior to Reading a monitor, be sure the preferences are set as you wish. If you have not 
moved your StepWatch program out of it’s home directory (you should not), the 
preferences will remain as the last user set them. If multiple people are using the system, 
check the preference settings for the divisions between activity levels. We recommend 
maintaining consistent activity level settings for all your data files. The defaults are 
advisable for most applications. See “Setting Preferences” on page 8 for further discussion. 
 
If you accidentally select "Start Recording Activity...” When you mean to read recorded 
activity, allow the communications to continue until the start StepWatch screen appears, 
then click cancel. Your data will not be compromised. 
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 When the data have been read you will see 4 tabbed windows. 

• “Summary Information” includes the monitor ID, notes you entered, the time the 
monitor was programmed, started, and read, a list of days the monitor was running, 
other information pertaining to monitor settings, and a graphical representation of 
the data for any chosen day. 

• “Edit Time” graphically shows minute-by-minute step plots of each day and allows 
you to select the time that will be included in your analysis. Double click on any day to 
access tools for including or excluding the day, or parts of the day, in your analysis. 

• “Activity/Rate” show various analyses of the data described below. 
• “Activity/Time” show various analyses of the data described below. 

 
The software menus provide options for printing and exporting the raw data and analyses. 
You can copy the graphics and text from the “Summary Information” and “Activity/Rate” and 
“Activity/Time” screens by using the “copy all text” and “copy graph” options in the Edit menu. 
There is also a database you can populate. 

$"#;'-&'>'5*%*6(5>#()#*+'#,*'-#=%*%#
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There are several tools providing graphical representations of the data. For a more complete 
understanding of the analysis calculations see “Analysis Variables and Calculations” on page 
18. 

!"#?!&3@#/)%0#A36)8##

Daily Step Plots show the raw data for each day with time (on 24 hour clock) across the 
bottom, and steps per minute on the vertical axis. Each small vertical line is one minute (if you 
have recorded in one minute intervals). The data represent step counts only for the leg being 
monitored. (Multiply step counts by 2 to compare with most other monitors). 

*"#A&%#B(!;)8##

Two types of pie charts on the Activity/Rate window compare a chosen day to the average for 
the included time in your data file. One shows the percentage of time spent at high, 
moderate, and low activity (and inactive if you wish) for both the average of all included time 
and the included time on a selected day. The other shows the percentage of steps taken at 
high, medium, and low levels of activity during the included time. 

-"#C!;#D;!0(8##

Bar graphs in the Activity/Rate window provide the option of showing minutes or steps for all 
of the days during the monitoring session at any combination of high, medium, or low activity 
levels. If you sort by one of the data columns at the top of the page (by clicking on its header) 
the bar graphs will reflect this sorting. 
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Bar charts on the Activity/Rate window compare activity levels during included time for a 
selected day with the averages for all included time in the file. The orange bars represent the 
average percentage, with the total minutes accumulated at this activity level on top. The 
yellow bars show whichever day is selected. The bar represents the time at that activity level 
as a percent of included time for that day. The total minutes at that activity level for the 
selected day are on top of the yellow bar. 

%"#/,8)!&1%4#!14#A%!.#E-)&F&)@#B(!;)##

The Sustained Activity Chart on the Activity/Time window shows graduated bars for the 
highest activity level sustained for continuous periods of 1, 5, 20, 30 and 60 minutes each day, 
and the line graph shows the peak activity index which is the average of the highest 30 
minutes of the day regardless of when they occurred (i.e. no requirement for continuity). The 
plots show the average for the entire monitoring period as well as each individual day. These 
measures are further described in the “Activity Time Calculations” in the “Analysis Variables 
and Calculations” section. 

7"#2%%.#5%06;)##

In Print Preview, you can generate a report for up to 7 days that gives the average steps per 
day (on one leg); the average number of minutes, the percent of active time, and the percent 
of all time at each activity level; and a maximum sustained effort/accumulated peak effort 
chart. This is in a format suitable for distribution to clients. Go to Print or Print Preview in the 
File menu to access this. 

'"#?!)!*!8%#<6638##

Several further tools for analyses and graphical representation of the data are available for 
records in the database. These include tracking of a person over time, and comparisons 
between groups of people. Refer to the database section for further information. 
 

("#/0;%!48(%%)8#

See “Export Data” on page 22 for descriptions of using spreadsheets. 
 

="#C64*'&657#=%*%#)(&#!5%4F>6>#
To specify which data you want included in your analysis, click on the “Edit Time” tab of your 
data file. This shows a step plot for each day recorded with time (on a 24 hour clock) along the 
bottom and steps per minute on the vertical axis. Each data line indicates the number of steps 
taken in 1 minute (if you have recorded in 1 minute intervals). If you are using the “Auto 
Exclude” option in “Preferences” (see page 8) you may see that some days are excluded 
already. 
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If you wish to move data from one day to another you may want to use the “Shift Time” 
function in the “Monitor Utilities”. Shifting time allows you to adjust the starting time of a file 
by whole hours in either direction. For example, if you have a person whose activity runs past 
midnight, and you want to use their continuous “waking hours” as the basis for your statistics, 
you can shift the data to accommodate this. 
 
“Shift Time” removes any existing editing of included time. If you are matching data to a 
log you may wish to keep a copy of the unshifted file while you are lining up time with the 
data. 

9"#$+%57'#U5/4@1'1#J6B'#

To change the time that is included or excluded in your analysis, double click on any day in 
the “Edit Time” window. An editing time window will open where you may alter the time that 
is included in a variety of ways: 

!"#/)!;)G/)60#C!;8#

Use your cursor to drag the “Start Time” and “Stop Time” bars across the plotted data. If you do 
not see these bars, they are at both ends of your plotted data. Move the cursor to either end 
until it becomes an " I " shape. Hold the mouse button down and drag. Release the button 
when the bar is in the desired location. You can use the digital time controls for fine 
adjustments. 

*"#?&'&)!3#<&=%#B61);638#

Use the digital time controls by clicking on the hour or minutes indicator for the start or stop 
time, then click on the arrows to the right of the numbers to control the number. 

-"#H1-3,4%GIJ-3,4%#?!@#

Click the "Include Entire Day" or "Exclude This Day" to achieve the desired result. 

4"#H1-3,4%GIJ-3,4%#5!1'%#

Use the “Include Range” or “Exclude Range” toggle buttons to control whether the time 
between your “Start” and “Stop Time” bars is included or excluded for analysis. 

%"#5%8%)#)6#K;&'&1!3#

Use the "Reset to Times Recorded” button to reset the day to the original state. This can be 
especially useful for partial days at the beginning and the end of a recording session. 

7"#:!.%#E33#?!@8#)(%#/!=%#

The "Make All Days the Same" check box applies the time selection for the day being edited to 
all the days in your file. This function can save you a lot of time (and clicking) in some 
circumstances. 
 
When you are satisfied with your time selection, click the OK button. 
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Partial Days: Be aware that your average statistics for percent time at the various activity 
levels and percent time inactive are referenced to your included minutes (total time at each 
level for all days divided by total included minutes for all days). If you are not including 
entire days or the same amount of time for each day, these results can be misleading. 
 
Database Records: Changing the included/excluded time in your database records will NOT 
update the analysis results. To do this, you must change the time in a data file then re-
submit it to the database (and delete the original record). If you have not saved the data 
file, simply open the database record in question and use the “Save As” command to save a 
new file. Edit the file, then re-enter it into the database. 

I"#!5%4F>6>#V%&6%E4'>#%51#$%4/@4%*6(5>#
All step counts are for one leg. Counts should be doubled for direct comparison to standard 
pedometer representations. 

3"#!:'&%7'>#

All averages are based on the whole and partial days you have chosen to include for analysis. 
Days that are entirely excluded will appear in italicized text in your analysis windows, but will 
not be included in the averages. 

!"#EF%;!'%#/)%0#<6)!3#

This is the average step total of all included days regardless of whether parts of the days are 
excluded. If you are only including entire days, this average will be the same as the “Average 
Included Steps”. Days that are entirely excluded are not included in this calculation. For days in 
which some time is excluded, the entire step count for the day is included in this calculation. 

*"#EF%;!'%#H1-3,4%4#/)%08#

This is the daily average of the steps taken during all included time. It is the sum of all 
included steps divided by the number of whole or partial included days. 

-"#EF%;!'%#:&1,)%8#!)#>61%L#96ML#:%4&,=#!14#$&'(#E-)&F&)@#

These variables reflect the percentage time spent at each activity level during the included 
time relative to the total included time. The percentages are calculated using the total minutes 
accumulated at each level divided by the total included minutes for all days. They are not the 
numeric averages of the percentage for each day relative to the included minutes for that 
day. 

4"#EF%;!'%#/)%08#!)#96ML#:%4&,=#!14#$&'(#E-)&F&)@#

These measures are the average steps per day accumulated at each activity level for all 
included time. 
 
Designations for Low, Medium and High Activity Levels: If you change your preferences for 
the divisions between activity levels, your statistics will automatically be re-calculated 
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once you re-open a data file. If you are working with records in your database, however, 
you will need to save the record as a file (using the “Save As” command), then make the 
desired changes to the file. Next, delete the original database record and re-enter your new 
file as a record in the database. 

9"#!/*6:6*FY;%*'#$%4/@4%*6(5>#

Note: To sort your days by any measure, click on the title bar for that measure in the statistics 
table in the “Activity/Rate” window. 

!"#/)%0#<6)!3#

Total number of steps in the day regardless of whether any or all of the day is excluded. 

*"#/)%08#H1-3,4%4#

Total number of steps in the time included for analysis. 

-"#:&1,)%8#H1-3,4%4#

Total number of minutes in the day included for analysis. 

4"#:&1,)%8#>61%#

Total minutes of the time included for analysis in which no steps were recorded. 

%"#:&1,)%8#96M#

Total minutes of the time included for analysis in which the step count fell between and 
inclusive of 1 and the limit set in preferences for Low Activity. 

7"#:&1,)%8#:%4&,=#

Total minutes of the time included for analysis in which the step count fell between and 
inclusive of the Low Activity limit +1 and the limit set in preferences for Medium Activity. 

'"#:&1,)%8#$&'(#

Total minutes of the time included for analysis in which the step count was greater than the 
Medium Activity limit set in preferences. 

("#/)%08#96M#

Total steps accumulated during the time included for analysis at step counts between and 
inclusive of 1 and the limit set in preferences for Low Activity. 

&"#/)%08#:%4&,=#

Total steps accumulated during the time included for analysis at step counts between and 
inclusive of the Low Activity limit +1 and the limit set in preferences for Medium Activity. 

N"#/)%08#$&'(#

Total steps accumulated during the time included for analysis at step counts greater than the 
Medium Activity limit set in preferences. 
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Each of these measures is derived by scanning the included time of a day with a "window" of 
the designated width (1, 5, 20, 30 or 60 minutes) and by extracting the maximum number of 
steps achieved at any continuous interval of that duration. That maximum is then divided by 
the duration of the interval to give the average steps per minute of that best performance. 
 
For example, for the 60-minute sustained activity calculation, the steps between 12:00 AM and 
1:00 AM are summed. Then the steps between 12:01 AM and 1:01 AM are summed. That process is 
continued for the entire day (or entire included time). The maximum sum is divided by 60 to give 
the average of the highest sustained 60-minutes for the day. 

*"#E-)&F&)@#H14%JO#C%8)#TS#:&1,)%8#

 The Activity Index represents the average step rate of the highest 30 minutes of the included 
time in a day, regardless of when they occurred. They may be scattered across the day. This 
differs from the Sustained Activity Measures that represent continuous blocks of time. 
 
To sort your days by any measure, click on the title bar for that measure in your statistics 
table in the Activity/Time window. 

K"#0%514657#=%*%#C64'>#
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The “Save” command under the File menu allows you to save step data to a file on your hard 
disk and to save alterations to a file already existing on your hard disk. If the file does not 
already exist on your hard disk (i.e. the data have just been read from the StepWatch or are 
from a database record for which there is no discrete file), a window will open that allows you 
to name the file and choose where to save it. If you are saving a file that you have opened 
from your hard disk, you will not be asked to name or choose the location for the file. 
 
The “Save As” command under the file menu allows you to name and choose the location for 
saving a data file on your hard disk. This allows you to assign a new name to a data set. This is 
useful, for instance, if you have changed the time included for analysis and want to preserve 
both the old and new versions. 
 
With either “Save” or “Save As”, the specifications for the time you have chosen to include or 
exclude for analysis will be saved with the file. The excluded data will not be lost and will be 
available for inclusion later. 
 
Note that the “Save” and “Save As” commands DO NOT SAVE RECORDS to the to neither 
database nor do they save alterations to database records. To save data to the database, you 
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must use the "Add [file name] to Database" command in the Database menu. See “Adding a 
Record to the Database” and “Altering a Database Record” on page 30 for further discussion. 
 
Windows Users Only 
On Windows machines, the StepWatch software automatically puts a .swb extension on the 
suggested file name when you use the “Save” or “Save As” commands. Some versions of 
Windows (such as XP) provide an option in the Control Panels (Folder Options/View) for 
showing or hiding extensions of known file types. If your control panel is set to hide file 
extensions, you will not see the .swb in the suggested file name when you use the “Save” or 
“Save As” commands. If you edit the suggested file name, the (invisible) .swb extension will 
not be appended to the name actually assigned to the file. 
In that case, to make your Open file list show the StepWatch data files, you have 3 options: 

• You may explicitly add a .swb to the end of each StepWatch file name when saving 
files. 

• You may change your “Control Panel” setting to show file extensions. 
• You may select “All Files” in the “File Type” pop-up menu in the navigation window that 

opens when you use the “Open File” command. 

*"#K0%1&1'#!14#B368&1'#V&3%8#

The following functions work for StepWatch files but not for database records. 
• Open: The Open command allows you to open a data file created by the StepWatch 2 

or StepWatch 3 program. To open files from previous versions of the StepWatch 
software, you must use the Import Data command. 
On machines running Windows, all files in a directory which end with .swb will show 
up in the list of StepWatch Document file types showing in your Open dialog box. To 
see files not ending with .swb, you will need to select the "All Files" from the File Type 
pop-up menu in your Open screen. 
The Open command will not open database records. For further discussion, see help 
for “Opening a Database Record” on page 30. 

• Open Recent: The Open Recent command allows you to quickly access any of the last 
5 data files that were opened. The data files are discrete files stored on your hard disk, 
in contrast to database records. If you move a file on your hard disk, the Open Recent 
command will not be able to find that file until it has been re-opened. 

• Import Data: The Import Data command allows you to import data files from versions 
of the StepWatch software prior to 2.0 and step activity spreadsheet files exported 
from StepWatch software. Once a file is imported, you may use the Save or Save As… 
commands to store the file in your current StepWatch format. You may also add the 
file to your database. The Import command will not open database records or files 
made with the Save Raw File command. 
 
If you intend to share data via email exchange, the most reliable method is to export 
your raw data file into spreadsheet format, and attach it to your email correspondence 
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in that format. The recipient can then import the data and save it in the native 
StepWatch format or as a database record. 

• Close: The Close command closes any data window including a database record. If the 
window contains step activity data that have not been saved to a file, you will be 
asked whether you want to save the file before closing. 

 

-"#:6F&1'#?!)!#!14#E1!3@8%8#)6#K)(%;#/67)M!;%#

These functions work for both files and database records. 
• Export Data: Step data may be exported to a tab-delimited spreadsheet using the 

Export Data option from the File menu. The first 27 rows of the exported file contain 
the StepWatch set-up and recording information. Row 24 indicates which data 
intervals were included for analysis using the convention: [include or exclude 
indicator]*[starting interval]*[ending interval]. The Include indicator is "i" and the 
Exclude indicator is "x." The counting is referenced to the first interval after midnight. 
(That interval is 1). The raw step data starts at row 28 and is divided into columns by 
day. The first column is time. You may use these files to perform custom analyses. 
Exported data files may later be imported back into the StepWatch program if the first 
27 rows are unchanged. 

• Export Analysis: Results of the Activity/Rate and Activity/Time analyses may be 
exported to a tab-delimited spreadsheet format using the Export Analysis option in 
the File menu. Both the average of the included time across all days and the results for 
each day are reported. 

• Copy All Text: You may copy your analysis results directly out of the StepWatch 
software by going to the “Activity/Rate” or “Activity/Time” screen and selecting Copy All 
Text in the Edit menu. You do not need to have any text highlighted. Results of all 
analysis measures except the percent time at each activity level for each day in the file 
or database record will be copied. 
If you Copy All Text from the Summary screen, the StepWatch setup information will 
be copied. After you have copied the text, simply use the paste command in another 
application to transfer your data into that program. 

• Copy Graph: You may copy the charts and graphs from the “Summary”, “Activity/Rate”, 
and “Activity/Time” screens of a file or database record by selecting the Copy Graph 
option in the “Edit” menu. It will copy the image that is showing. Then, you may paste 
it into any application with compatible graphics support. 

• Moving Database Analyses to Other Software: The Database Group Statistics 
function has an option to export the results to a tab-delimited file. Also, you can use 
the Copy All Text command in the Edit menu to move the results of the Database 
Summary and the Comparisons to other software. 
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These functions work for both data files and database records. 
• Page Setup: The Page Setup command under the File menu gives the standard page 

set up options applicable for your chosen printer driver. Note that on many machines 
running Windows, your page margins will need to be set at zero for the printing to 
work properly. 

• Print Preview and Print: Most of the information visible in the downloaded 
StepWatch file or database record may be printed. A one-week summary report can 
also be selected. Both the Print and Print Preview commands in the File menu allow 
you to specify which days of data to print, the number of charts to include per page, 
and the type of text or graphical data (e.g. Statistics, Daily Step Plots, etc.). You must 
choose at least one data type. 
Prior to initiating the Print Preview, we recommend you check your Page Setup 
settings. If you want to use different page setups for printing the different data types 
for a file, you will need to select those data types in separate Print Preview or Print 
sessions, and modify your Page Setup between sessions. If you are using a computer 
running Windows, and your previewed or printed pages seem clipped at the edges, 
use the Page Setup to set all four margins to zero. Preferences also allow you to 
control whether the colored bands designating low and medium activity levels and 
the horizontal grid lines are shown on step plots, and give you the option of 
customizing text in the footer. 

UUU"#P:'&:6'2#()#G>657#*+'#,*'-.%*/+#=%*%E%>'#
• The StepWatch database is a powerful tool. It is important to familiarize yourself with 

the workings before implementing it into your projects. It is not difficult to use, but it is 
important for you to familiarize yourself with some of its basic principles, functions 
and terminology. 

• The database is NOT meant to serve as the means for storing all your data. Its 
purpose is storing your "good," finalized, filtered data. While you are "playing" with 
your data, it's best to store the files in folders on your hard disk (e.g. the "Client Files" 
folder in the StepWatch Library). Every data set you enter into the database will 
influence your summary measures. 

• To help distinguish between data stored independently in folders on your computer 
and data stored in the database, we use the following terminology: 
FILE = a monitoring session stored OUTSIDE OF the database. 
RECORD = a monitoring session stored IN the database. 
You, (the user) enter information about your client then attach their data file as a 
database record. Once you have added a file to the database it becomes a "record." 
Your file will also remain, separately. 
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• The database does NOT dynamically recalculate results when you make changes to 
your preferences (e.g. cut-offs for low, medium and high activity) or to the filtering 
parameters of a file or record.  The way to make the analysis results for a record reflect 
changes to program preferences, the record’s time filtering, or the client’s date of birth 
is explained in “Altering a Database Record.” 

• If you open and make changes to a file (stored on your hard disk outside of the 
database), the changes will NOT be reflected in your database records or database 
summary measures even if you had previously submitted that file as a database 
record. The software keeps no connection between the file and the record. 

• You may assign your clients to groups that you or others define. The database gives 
summary statistics for: users, clients, and groups, and individual statistics for the 
current user’s clients It also provides comparisons of individuals to themselves over 
time, individuals to groups or the whole database, and comparison of a group to 
another group or the whole database. 

• You may work with the database as a public or private user. As a private user your 
individual client records are private and if you need comparisons and summary 
measures that reflect only your private data, you can establish private groups or 
private IDs and assign your clients to those. 

• Most database summary measures for groups designated as “public” and the 
"Everyone" group are influenced by records input by all users at your site who have 
clients assigned to those groups. See “Group Stats” for the exception to this. 

 
Some database capabilities are new additions to the StepWatch software. We have tested 
for bugs, but if you find discrepancies please notify us. As a standard data safety 
precaution, we recommend you create an independent back up of database records by 
storing your downloaded files in the “Client Files” of your StepWatch Library or elsewhere 
on your hard drive or backup disks. (If you wish to back up the database itself, see the Note 
in “Restoring Database from Backup”). 
 
If you ever suspect that your database is corrupted, do not quit the StepWatch program. 
See instructions for “Restore Database from Backup” in “Troubleshooting”. 
 

!"#=%*%E%>'#G>'&>#
You may use the database as either a general user (Public) or a private user. As a private user, 
you will be able to set up groups that are either public or private. No other users will have 
access to your individual client records or your private groups. Others will have access to 
summary measures from your public groups and will be able to include their own clients in 
your public groups. Others will not have access to your individual client records even if your 
client is included in public groups. 
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If you choose to access the database as a Public user, simply select Log In from the Database 
menu. Then click the Log In button. As a public user, you have access to summary measures 
from any public group and will be able to add records to any public group. Remember that 
any record you add will affect the summary measures of the public groups to which your 
client is assigned, so be sure you are only adding quality data. It is also important to realize 
that any others logging in as public will have full access to all of the individual client records 
you store here. 

9"#A&6:%*'#G>'&#

To create a Private User account, select Log In from the Database menu. Click the New User 
button and then give yourself a user name and password. Click the Log In button. Remember 
your password! 

!"#B(!1'%#W8%;#>!=%GA!88M6;4#

To change your password, log into your user account then select My User Account from the 
Database menu. Type and verify your new password in the fields provided. You can also use 
this screen to rename your account. If you want to transfer your data to another user on a 
different computer, contact Orthocare Innovations for instructions. 

*"#?%3%)%#!#W8%;#E--6,1)#

 To delete a user account, log in to the account then select My User Account from the 
Database menu. Click the Delete button. Deleting an account will delete all the clients, data 
records, and public and private groups that were created/input through that user account. An 
exception to this is if a group contains other user’s clients it will not be deleted. Deleting a 
user account may not be reversed except by restoring the database from backup before 
quitting the StepWatch program. 
 
The public user account may not be deleted. 

?"#G>657#G>'&L=')65'1#W&(@->#
Creating custom groups to which you assign clients is one of three means available for 
customizing the organization of your database records, generating summary statistics, and 
comparing clients. (The other two means are specifying Private IDs and including or excluding 
clients from the “Everyone” group.) Each client may be assigned to two custom groups. 
 
You may create a new group by using the “Add New Group” command in the “Database” 
menu. A window will open that allows you to name the group and enter notes describing the 
group. You may create as many custom groups as you wish. 
 
Once you have created a group, you may assign a client to that group at any time by selecting 
the desired group from the pop-up menu in the “Add” or “Edit Client” option in the “Database” 
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menu. You may also add clients and activity records to other users’ public groups. For further 
information on assigning clients to groups see “Add a New Client” on page 27. 
 
If you are logged into the database as a private user, you have the option to make the group 
either private or public. 

3"#A&6:%*'#W&(@->#

If you make the group private, no other users will be able to add clients to the group. Other 
users will be able to see that your private group exists in their Database Summary, but they 
will not be able to see summary data. 

9"#A@E46/#W&(@->#

If you make the group public, other users will be able to add clients to the group, see 
summary data for the group and add descriptive notes to the group. Other users will NOT be 
able to delete the group, or see individual client data that has not been entered from their 
user account. 
 
If you create a group while logged into the database as the public user, your groups will 
automatically be public. All other users will be able to add clients to the group and view 
summary data for the group. Anyone logged in as Public would be able to see individual 
client data for the group or to delete the group. 
 
The summary data in all places except Group Stats (“Database Menu” option) reflect all clients 
who have been assigned to the group by all users. You will not be able to access individual 
client data for clients assigned to your group by other users. Others’ data will, however, be 
reflected in your public group’s summary statistics. Group Stats provides individual and group 
summary data only for the clients the logged in user has assigned to the group. 

<"#I16*657#%51#='4'*657#W&(@->#

You may alter the name or description of a group using the Edit Group option in the Database 
menu. Changes made to either will be updated automatically for clients already assigned to 
the group. 
 
A Public Group that has any other user’s clients in it should not be changed to private. 
 
Use caution when deleting groups. Confirm that no clients are assigned to the group before 
deleting it. You can use the Group Stats function to obtain a list of your clients assigned to the 
group, then change each client’s assignment using the “Add or Edit Client” function. If the 
group is public and other users have clients assigned to the group they will need to remove 
their clients from the group also. To delete the group, use the "Edit Group" option in the 
Database menu. Select the group you wish to delete from the pop-up menu that lists all 
groups accessible to you. Click the Delete button. You are only able to delete groups (private 
or public) that you have created from your user account. 
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Deleting a group will not delete clients or activity records. 

$"#G>657#J+'#I:'&F(5'#W&(@-#
The Everyone Group is a special public group that is meant to provide summary and 
comparison measures for the entire database. By default all clients are included in the 
“Everyone” group. You may exclude any client from Everyone by clicking the check box for 
"Exclude this client from the Everyone group" when you Add or Edit a Client. Including a client in 
“Everyone” does NOT allow other users to access the individual data for that client. 
Others will only be able to see summary statistics for the Everyone Group and the individual 
data that they have added. All users at your site can add data to and view summary statistics 
for the “Everyone” group. 
 
The “Everyone” group provides the overall summary statistics for the database at your site. 
When you use the "Compare Client to Database" option in the Compare functions of the 
Database menu, you are comparing your client to the averages of all records of all clients 
included in “Everyone”. 

="#$46'5*>#
To enter a record into the database, you must first set up a "Client" with whom the record is 
associated. 

3"#!11#%#S'2#$46'5*#

Select "Add or Edit Client" from the Database menu. Click the New Client button at the bottom 
of the window and enter your client information. The last name or identification code, 
gender, date of birth, and postal zip code are required fields. The information shown in the 
Contact Info tab includes when the information on this client was last modified. The client 
information is stored separately from the database and, except for date of birth, may be 
modified independently of the database. When you have completed entering the client's 
information click either “Save” if you wish to enter another client, or “Done”. 
  
You may choose to associate a client with any or all of three kinds of groupings: “User-Defined 
Groups,” “Private ID”, and the “Everyone Group. A client must have an activity monitoring 
record assigned to them to be counted in a group. 

!"#E88&'1&1'#B3&%1)#)6#W8%;X?%7&1%4#D;6,08#

You may associate a client with up to two custom groups (created by you or other users) by 
using the pop-up menus for group assignments. The pop-up menu will allow you to select 
any public or private group you have created within your user account and any public group 
created by other users. If you add data to any public group, be aware that your data will be 
included in the summary measures that all other users will see. If the owner of a public group 
is going to delete that group or make it private, you should remove your client’s assignment 
to that group first. 
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Note: The primary and secondary groups to which a client is assigned are treated as 
equivalent to each other in database comparisons. The primary and secondary groups do 
not limit or qualify each other. 

*"#E88&'1&1'#B3&%1)#!#A;&F!)%#H?#

The Private ID is a special kind of group that is not available for other users to see or access in 
any form. Within your user account, you can use the Private ID as a basis of comparison for 
clients or groups using the Compare functions in the Database menu. If another user 
designates the same private ID, your comparisons will not include their clients. 
 
The Private ID can facilitate applications in which it is impractical to create groups for all 
possible classifications. For example, you might use it to encode International Classification of 
Disease (ICD) categories. 
 
The Private ID can also allow you to designate subgroups within your groups for exploratory 
purposes. For example, within a group of clients with limb amputation, you might create 
subgroups with the Private IDs "diabetes," "traumatic," and "other" to explore whether there 
are differences related to amputation etiology. 

-"#H1-3,4&1'#B3&%1)#&1#)(%#IF%;@61%#D;6,0#

By default all clients are included in the “Everyone” group. You may exclude any client from 
“Everyone” by clicking the check box for "Exclude this client from the “Everyone” group" when 
you “Add” or “Edit a Client”. “Everyone” is a public group to which all users can add data and 
view summary data. The “Everyone” group is meant to provide overall summary data for the 
database. When you use the “Compare Client to Database” option in the compare functions of 
the Database menu, you are comparing your client to all records of all clients included in 
Everyone. Including a client in the “Everyone” group only includes that person in the database 
summary statistics but will NOT allow other users to access the individual data for that client. 
 
When you have completed entering the client information if you wish to enter another client 
click “Save” otherwise click “Done”. 

9"#I16*#%#$46'5*#

After you have added a client to your database, you may use the “Add” or “Edit Client” function 
in the Database menu to update the client information at any time. Select the client you wish 
to edit from the list. When finished, click “Save” or “Done”. Once edited, all new client 
information with the exception of changes to date of birth will be associated with both 
previous and future records for that client. 

!"#I4&)&1'#?!)%#67#C&;)(#

If the date of birth has originally been entered erroneously, you will need to delete and re-
enter any step data records previously submitted to the database for that client. . If you do 
not do this, the records entered previous to the correction will not reflect the correct age. 
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In this situation, the safest way to delete and re-enter a record from the database is as follows. 
• Make the date of birth change in the client information using the Edit Client function 

in the Database menu, then click “Save”. 
• Open any step data record submitted for that client previous to the birthdate change 

using the "Open Activity Record from Database" option in the Database menu. 
• Save the record to a file on your hard disk using the “Save As” command in the File 

menu. 
• Delete the record from the database using the "Delete Activity Record from Database" 

option in the Database menu. 
• Re-submit the file to the database using the "Add File [file name] to Database" option in 

the Database menu. To do this, the file you want to add must be in the active window 
(the one in front) on your screen. 

  
You do NOT need to delete and re-enter database records when you make other changes 
such as when you change the Groups, Private ID or Everyone inclusion/exclusion 
assignments for a client. Database summary measures will automatically reflect these 
changes. 
 
If you wish to change the group designation for all clients in a group, see the suggestion in 
“Editing and Deleting Groups” on page 26. 

*"#?%3%)%#!#B3&%1)#

To delete a client, choose the "Add” or “Edit Client" option in the Database menu. Select the 
client you wish to delete from the list. Click the “Delete” button and click “Save” or “Done”. 
Deleting a client will delete all the step activity records in the database that have been 
assigned to that client. This action may not be reversed except by “Restoring the Database 
from Backup” before quitting the StepWatch program. 

I"#0%514657#=%*%E%>'#;'/(&1>#
To add step data to your database, you must have the step activity data file as the active 
window (the one in front) on your computer screen. This can be either data just downloaded 
from your StepWatch or data from an opened or imported file on your computer. 

P"#C%76;%#E44&1'#!#5%-6;4#)6#)(%#?!)!*!8%#

• You must previously have added the associated client to the database using the “Add” 
or “Edit Client” function in the Database menu. You may then assign multiple step 
activity records to any one client.  

• Be sure your “Low Activity” and “Moderate Activity” level preferences are set to the 
levels you want. The setting for High Level activity does not affect your statistics. (See 
“Activity Level Definitions” for a discussion of choosing activity levels). If you make a 
change to your preferences, you need to close and re-open your file before submitting 
it to the database. We recommend deciding on your activity level settings before you 
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start data analysis, then leaving the levels constant to avoid inconsistencies in your 
data. 

• Be certain that you have specified the desired included and excluded time for every 
day in your data file. Once you have submitted a record to the database, you cannot 
alter this without deleting the record and reentering it with the desired changes. See 
“Filtering Data for Analysis” and “Altering a Database Record” below on this page for 
more information. 

R"#E44&1'#!#5%-6;4#)6#)(%#?!)!*!8%#

 When you are satisfied that your file is in order, select the "Add [file name] to Database" option 
in the Database menu. A window will open that allows you to choose the client to whom the 
record will be associated from a pop-up menu of all clients you have entered. You may sort 
this list by clicking on the header for any of the columns. When you select the appropriate 
client, you may add notes associated with the data. These notes will be visible to you anytime 
you use the “Open Record from the Database” command. Click “Add Record” to submit the data 
to the database. 
 
If you have already entered the same data into the database, a warning message will appear, 
giving you the option to proceed or cancel. This warning does not occur if one of the files has 
been time shifted (See “Filtering Data for Analysis: Shift Time” on page 17). 

T"#K0%1&1'#!#?!)!*!8%#5%-6;4#

To view a record from the database, use the "Open Activity Record from Database" option from 
the Database menu. A window will open which allows you to specify the client with whom 
the record is associated via a popup menu. When you select a client, you will see a list of data 
records associated with that client. Click on the chosen one to highlight it then click the 
“Open” button. 

Y"#E3)%;&1'#!#?!)!*!8%#5%-6;4#

To make the analysis results for a record in the database reflect changes to your program 
preferences, inclusion or exclusion times, or the client's date of birth, you must re-enter the 
file in the database with the desired changes and delete the old record from the database. 
 
If you open and make changes to a FILE (stored on your hard disk outside of the database), 
the changes will NOT be reflected in your database records or database summary measures 
even if you had previously submitted that file as a database record. Also, if you open a 
database record and alter included time, the software will ask if you want to save this as a 
File. Doing so makes a File -- not a database Record; nothing in the database will have been 
changed. 
 
The most advisable way to alter a database record is: 

• If applicable, make and save changes to your program Preferences (e.g. “Low Activity” 
or “Medium Activity “ level designations) or the client's date of birth. 
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• Using the "Open Activity Record from Database" option in the Database menu, open the 
step data record that needs to be changed. 

• Make the desired changes (e.g. altering the time included for analysis). 
• Save the data to a file on your hard disk using the "Save As" command in the File menu.   
• Delete the record from the database using the "Delete Activity Record from Database" 

option in the Database menu. 
• Re-submit the file to the database using the "Add File [file name] to Database" option in 

the Database menu. To do this, the file you want to add must be in the active window 
(the one in front) on your screen. 

C"#=%*%E%>'#$(B-%&6>(5>#
 The “Compare Functions “in the Database menu allow you to compare individual clients to 
themselves over time, to groups, and to the database. You may also compare groups to the 
entire database or subsets of the database. 
 
When you choose one of the “Compare” options (Client to Self, Client to Database or Group to 
Database) a window opens for you to select the individual or group you wish to compare. For 
client comparisons you may limit this selection list to only one gender or sort it by clicking on 
any of the headings. Then a window will open that provides information about the client or 
group selected and allows options for limiting the group/or whole database against which 
you are comparing your client or group. The limitations can be specified by age, gender, 
group, or “Private ID”. The age limitation may be within a specified number of years plus or 
minus or may be a specific age range. Note: If you limit the comparison by private ID you will 
only be comparing to your own clients who have that “Private ID”. 
 
When you compare a client or group to the database, you are comparing against all records in 
the database assigned to the “Everyone” group. If the client or members of the group you are 
comparing is/are included in “Everyone”, their data will also be represented in the Everyone 
statistics. Likewise, if you compare a client to a group of which they are a member, the client's 
data will be represented in the group's statistics. 
 
The menu items for “Client Comparisons to Normal Activity” and “Group Comparisons to Normal 
Activity” are not yet implemented. 

W"#,@BB%&68657#,*%*6>*6/>#

3"#C@44#=%*%E%>'#,@BB%&F#T'%>@&'#

“My Database Summary” in the Database Menu provides summary statistics about the 
database without showing information on the individual clients or other users private groups. 
The number of database users, summary information on the gender and age of your clients 
and their activity is given. The summary information for the “Everyone” group, all public 
groups, and your private groups includes the total days analyzed, the average number of days 
analyzed per client, and the minimum and maximum number of days analyzed per client. The 
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number, gender and the age average and range of clients in the group are provided. 
Summary statistics include the average, minimum and maximum averaged daily step count, 
the time spent at high, medium, and low activity, and inactive as well as the activity and peak 
indexes. Each individual’s statistics used in these calculations are derived from the average of 
each day that has time included for analysis. The individual client's statistics are not viewed in 
this summary. 
  
If you have a large database, generating summary statistics will take some time. 

9"#W&(@-#,*%*6>*6/>#)(&#X(@&#$46'5*>#

The “Group Stats” option in the Database Menu uses only your clients in its calculations; other 
users’ clients are not included. It allows you to view summary measures for your groups and 
individual clients. Group summary measures provided are the average, standard deviation, 
minimum, maximum, and median for each of the following: age, daily step totals, percent of 
time at high, medium, and low activity, percent of time inactive, the activity index, the peak 
average number of steps at 60, 30, 20, and 5 continuous minutes, and the peak one minute. 
 
Each individual's statistics reflect averages across all days with included time in their database 
record. The groups may be limited by gender, and the gender of each individual is indicated. 
 
If your database has more than one user, only the clients of the user currently logged in are 
included. 
 
If a client has more than one record included in the database, each record is counted as if it 
were for a separate individual; in this particular calculation the number of people reported 
in the group is actually the number of records assigned to the group. 

UV"#P:'&:6'2#()#!1:%5/'1#A&(7&%BB657#
You have the option to manually specify your StepWatch settings using the “Advanced 
Programming” mode. This can be accessed through the “Utilities” portion of the Monitor 
menu. 
 
Advanced Programming should only be used if you are experienced with the StepWatch. This 
mode gives you direct access to the many StepWatch settings and allows you to customize its 
response for unusual clients or applications in ways not permitted by the regular Start mode. 
If you use the Advanced Mode without understanding the controls, you can program the 
StepWatch to behave in ways you did not intend. This will not hurt the StepWatch, but could 
reduce the quality of your data. 
 
When you launch “Advanced Programming”, the settings currently stored in the StepWatch 
memory will be read and displayed. You may alter any of these settings within limits. If you 
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are unsure whether your choices are appropriate, you can click the "Reset to Defaults" button 
to return the settings to their default state, and then reconsider how to modify them. (No 
matter how you change the settings in the Advanced programming, if you return to the 
regular “Start”, the settings always begin as the default and be altered appropriately). When 
you are satisfied with your settings, click the “Start” button to initiate programming. 
 
The “Sensitivity” setting is based on the individual calibration value for each StepWatch. This 
information is available in the calibration panel. The same settings will have different effects 
on the performance of different monitors. The specific values of all other Advanced 
Programming settings give consistent results between monitors. 

!"#,'5>6*6:6*F#
The Sensitivity and the Cadence are the most important settings for customizing your 
StepWatch to the gait style of any client. The “Sensitivity” determines how much movement 
is necessary for a step to be detected. The setting is dependent both on the mechanics of the 
client and the particular threshold level of each individual monitor. The following table gives 
you the recommended ranges, but you may want to go outside them for clients with unusual 
gait styles. You can see the threshold on the advanced programming screen in the scrolling 
field labeled “Calibration”. 
 
It is important to remember that RAISING the numerical value of the Sensitivity setting 
makes the StepWatch LESS SENSITIVE to movement. 
 

SUGGESTED SENSITIVITY SETTINGS BASED on THRESHOLD VALUES 
Calibrated Threshold Suggested Setting Setting Range* 

1.05 16 12 to 20 
1.06 15 11 to 19 
1.07 14 10 to 18 
1.08 13 9 to 17 
1.09 12 8 to 16 
1.10 11 7 to 15 
1.11 10 6 to 14 
1.12 9  5 to 13 
1.13 8 4 to 12 
1.14 7 3 to 11 

*This range is a starting point. You may want to go outside of it for unusual clients 

?"#$%1'5/'#
Sensitivity and Cadence are the most important settings for customizing your StepWatch to 
the gait style of any client. The “Cadence” effectively limits how quickly steps can be detected 
and helps you avoid double counting steps. The “Cadence” is set in increments of 1/100ths of 
a second. 
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RAISING the numerical value of the “Cadence” will LOWER the maximum rate at which steps 
can be detected. So the higher the “Cadence” number, the less often it will be ready to count a 
new step. The “Cadence” value should be set as high as is possible without missing steps at 
your client's most rapidly stepping pace. 
 
Normal values for adults are 60 - 80. Bias toward the higher numbers for people who take 
steps very slowly or who have long legs, bias toward the lower numbers for people who take 
steps quickly or have short legs. Children without disability are often in the 40 - 60 range. 
  
To find out what the normal cadence is for a particular height, program the monitor with 
quick start at that height and all settings at normal. After it starts to run, read the monitor 
then start it with advanced programming. The cadence shown will be the cadence for a 
person of that height with normal gait and normal walking speeds. 

$"#P*+'&#!1:%5/'1#A&(7&%BB657#,'**657>#

3"#J+&'>+(41#

The Threshold is the first level of the StepWatch's sensitivity to acceleration. At the time of 
manufacture, the threshold is calibrated in "G-force" response to a resolution of 0.001 G. The 
threshold is stored to the StepWatch memory. 
 
You can see your StepWatch's threshold by using the “Read Current Settings” command in the 
“Utilities” section of the “Monitor” menu or by launching “Advanced Programming”. The 
threshold value is also recorded on the calibration sheet provided with your StepWatch, and 
shown on the summary window of a downloaded file. All StepWatch 3 monitors have only a 
Null threshold, which is shown on the calibration panel. 
 
The older StepWatch 2 monitors have three thresholds, but should normally be used at the 
one identified as the default. 
 
If you are using the “Advanced Programming” to start your StepWatch, be sure to check that 
you have selected the desired “Sensitivity” to match the monitor's threshold calibration value 
(See discussion of Sensitivity above). 

9"#T(1'#

 The StepWatch operates in three different states. Through “Advanced Programming”, you can 
explicitly set it to any of the states. The “Advanced Programming” screen will always open with 
“Record” set as the default. You will not need to change this except under the guidance of 
StepWatch tech support personnel. 
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 This setting determines how frequently step counts are recorded. The recording interval 
(epoch) is set in seconds with options ranging from 3 to 180. We strongly recommend using 
60 (1 minute) for long-term monitoring sessions. One-minute intervals will allow you to 
directly compare your data with that collected by others using this standard unit. StepWatch 
3 units can generally collect 6 – 8 weeks of data at 1-minute intervals.  
 
StepWatch 2 units can generally collect 3 – 4 weeks at 1-minute intervals. 
 
You may wish to use shorter intervals for accuracy trials. 

K"#$(@5*#,/%4657#

 This is a simple multiplicative compression scheme which allows you to record numbers 
larger than 255 per recording interval (epoch). The “Count Scaling” should normally be left at 
1. If you use 1-minute intervals, you won't need to use “Count Scaling” because your step 
counts will not exceed 255 per epoch. If you use intervals greater than 2 minutes, you may 
want to use a “Count Scaling” greater than 1. 

N"#=%*%#$(B-&'>>6(5#

 This should be kept “ON” because it extends your maximum monitoring time and it reduces 
the demand on your StepWatch battery. It allows the monitor to use less recording space for 
inactive time. There is no 'down side' to using this. 

O"#=%F>#*(#;'/(&1#

 The maximum days to record is determined by the interval, the use of rest time compression, 
the percent time active set in Preferences and whether you are using a StepWatch 2 or 
StepWatch 3 monitor. See further description in “Setting Preferences” on page 8. 

Q"#DI=#C4%>+'>#

 In “Advanced Programming” you specifically set the number of LED flashes each time. The 
number set in preferences is ignored. For a further description see “Setting Preferences” on 
page 8. 

R"#?%**'&F#

 If you wish to check the battery level on a monitor you can see an estimate of the percent 
battery life remaining in the panel with calibration information. (This information is also 
available in “Read Current Settings” and on the “Summary” page of every downloaded file). 

Z"#,*%&*#J6B'#%51#S(*'>#

 In “Advanced Programming” you are able to set the start time for now or later, but not later in 
another time zone. You may also enter notes that will appear in the data file on the 
“Summary” window. When you are satisfied with your settings click the “Start” button. 
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 Be sure that you have specified an adequate number of LED flashes for the following 
procedures. You should check that your settings work correctly with each client by having 
them walk at their normal pace while you observe the LED blinks. If the StepWatch is not 
responding appropriately, use the guidelines below to adjust settings. Then, observe the 
response to the following two conditions: 
 

3"#0%:'#F(@&#/46'5*#2%4H#%*#*+'#>4(2'>*#-%/'#*+'F#2(@41#':'&#16;=!33@#2%4H"##

Watch the StepWatch light to see that steps are not being double counted. If you are 
seeing double counts you have two options: 

• Increase your Cadence value, or 
• If your client has very dynamic motion at the ankle and utilizes a wide range of 

cadences, RAISE the numerical value of the Sensitivity setting while keeping the 
Cadence value small enough to accurately capture fast cadences. 

  

9"#0%:'#F(@&#/46'5*#2%4H#%*#*+'#)%>*'>*#-%/'#*+'F#2(@41#':'&#5(&B%44F#2%4H"##

Watch the light to see that steps are not being missed. If you see missed steps or if you 
notice that the light tends to blink at different points in the gait cycle during consecutive 
steps (which may make you feel uncertain about what you have observed) you have two 
options: 

• You can lower the Cadence value and try again, or 
• If your client has unusually gentle motion at the ankle (like with shuffling gait), you 

may need to LOWER the numerical value of the Sensitivity setting to avoid missing 
steps. 

 
Be sure your client does not try to look at the blinking light for this will cause them to walk 
with a distorted gait. If they routinely run or do other quickly stepping activities, you may 
want to have them demonstrate the activity so you can evaluate the performance of the 
monitor by watching the light blink or by doing an accuracy trial. 
  
Be sure your client understands that the LED will not be flashing during their monitoring 
session. If your client expects the monitor to flash, they may assume it is not working when 
they do not see flashes and decide not to wear it. 

I"#!//@&%/F#J&6%4>#
If you want to conduct accuracy trials, you may wish to use a recording interval of 10 to 15 
seconds rather than 1 minute because, to locate your accuracy trial in the exported data, you 
need to have zeros in the file before and after the trial. When using a recording interval of 10 
or 15 for an accuracy trial, note the time you begin and have your client sit or stand still for 30 
seconds or more immediately before and immediately after the accuracy trial. The trial will 
thus be sandwiched by zeros that will allow you to locate it and match up the manual step 
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counts. During accuracy trials, it is helpful to have two observers both using hand held tally 
counters (available in office supply stores). Having two observers with hand-held counters 
allows them to talk casually with the client, thus reducing gait changes due to self-
consciousness; it also lessens the effect of observer counting errors. 
During the trial, LED flashes should be set to a minimal number so the StepWatch does not 
cue observers’ counts. Have the client walk at his/her normal pace in an unobstructed area, 
with the observers walking alongside or following. Be sure the observers are counting only 
when the leg wearing the StepWatch takes a step (rather than when steps are taken with each 
leg.) It takes some practice to count accurately because an observer's own walking cadence 
can interfere with counting the client's steps. If your accuracy trials are short, any error by the 
observers will result in a relatively large misrepresentation of the StepWatch accuracy. 
 
When the trial is completed, download the data and export it to a spreadsheet file using the 
"Export Data" command in the “File” menu. Open the file in your spreadsheet program. Scroll 
down to the time at which you conducted the trial. If your client stood still for an adequate 
time before and after the trial, the walking trial will appear as a string of similar values with 
zeros immediately before and after. Average the observers' manual counts and compare with 
the StepWatch count. 
  
If you are conducting accuracy trials but wish to use the cadence and sensitivity settings as 
determined for your client by the quick start functions, program the monitor using this 
means. After the monitor has begun recording, reprogram it with advanced start and 
change only the Interval and LED flashes. 

V"#J&(@E4'>+((*657#
The StepWatch program provides some tools to assist in troubleshooting including messages 
during the program operation and several diagnostic tools in the menu. The “Help” functions 
available in the software are also useful and, for some topics, provide more information than 
this manual. Check the Orthocare Innovations web site for a list of known issues and fixes; 
otherwise, Orthocare Innovations for technical assistance. 

!"#$(BB@56/%*6(5>#I&&(&>#
If you are not able to read your StepWatch or if the red and blue lights are flashing on your 
StepWatch 3 dock: 

• Check the connections between the dock and the computer. 
• Make sure the StepWatch is properly aligned on the dock. 
• Make sure there are no bright lights shining on the StepWatch. Halogen lights can be 

especially troublesome. Sunlight from some angles can also cause problems with 
StepWatch 2 docks and require shielding.  The infrared lights of some motion analysis 
systems also make shielding necessary. 

• Verify that your Communications Preferences have the correct port specified. 
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• Verify that the computer can communicate with the dock and the StepWatch by using 
the “Communications Test” below on this page. 

• Check that you do not have email or Internet browser software running in the 
background. Intensive networking software can also cause errors. 

• Sometimes simply waiting for a while before attempting to read the StepWatch again 
solves the problem. 

• If you have not replaced the batteries in your StepWatch 2 dock recently, you may 
need to do so. Frequent problems with the same monitor are often the first indication 
that you need to change your dock batteries. Some monitors require greater dock 
battery power than others for effective communication. To replace batteries see “Using 
the Dock” on page 7.  (The StepWatch 3 dock does not have batteries). 

If you are not able to solve the problem, contact Orthocare Innovations Technical Support. 
It is helpful if you have the exact wording of any error message and just when it occurs. We 
are happy to try to help you try to solve the problem. 

?"#$(BB@56/%*6(5>#J'>*#
You may use the Communications Test (in the “Utilities” portion of the “Monitor” menu) to 
check that your communications preferences and hardware are set up correctly and the 
StepWatch software is able to "talk to" the docking station and StepWatch. 

• Click the "Check Dock" button to verify that your computer is in communication with 
the docking station. You do not need to have a StepWatch on the dock to do this. 

• You may click the “Check StepWatch“ button to verify that your StepWatch is properly 
communicating. The “Communications Test Advanced Settings” should only be used 
with StepWatch technical support. 

$"#;'%1#$@&&'5*#,'**657>#
 You can use the “Read Current Settings” option in the “Utilities” section of the “Monitor” menu 
to quickly verify the settings in your StepWatch memory. Do not use this to verify the settings 
after you have programmed a monitor, as it will stop the monitor from recording. This 
function is intended to provide a means for conveniently checking the settings or notes in the 
memory of a monitor not in use. You can also use it to verify that a StepWatch is asleep and 
see the threshold calibration. 
 
Caution: If you have programmed a StepWatch to start recording but it has not yet started 
recording it is especially important that you, DO NOT read current settings. Doing so can 
cause inconsistencies in parameters written to the StepWatch memory which can cause 
short-term errors in programming and downloading. The damage is not permanent, but 
you may have to wait for a day or more before the StepWatch returns to its normal state. 
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The Communications Log keeps a record of every time you program and download any 
StepWatch. This may be useful to you if you are unsure of the location or the state of a 
monitor. The log does contain all your monitor setup information, but in a fairly cryptic form. 

I"#;'>*(&657#=%*%E%>'#)&(B#?%/H@-#
To protect you from data loss due to file corruption following a computer crash, power failure 
or other source, a database backup is automatically stored in the “Program Folder“ in your 
StepWatch Library every time you quit the StepWatch program. 
 
IF YOU SUSPECT THAT YOUR DATABASE IS CORRUPTED, DO NOT QUIT THE STEPWATCH 
PROGRAM. Use the "Restore Database from Back Up" option from the “Utilities” portion of the 
Database menu to revert to the database as it was the last time you quit the StepWatch 
program. 
 
If you quit the StepWatch program with a corrupted database, the corrupted database will 
be saved to back up and you will not be able to restore the database using this command.  
Contact StepWatch Technical Support for possible help. We are developing the means to \ 
rebuild your database from log records that exist in your Program Files provided you have not 
altered or deleted this folder or directory. 
  
If you wish to make your own database back up you can duplicate the “Client Database” 
and “Activity Database” files that are in the Program Folder/Directory of the Library in you 
StepWatch application. Move these duplicates out of the StepWatch folder, and store them 
elsewhere. If you have a large database it is not a bad idea to do this once in awhile. 
 #
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Size     75 x 50 x 20 mm 
Weight    38 grams 
Battery    750mAh Lithium 
Battery Life    Depends on usage. 7 years with heavy use 
Accuracy    >98% independently validated 
Sensitivity    User adjustable via software 
Sampling Rate   128/sec 
Housing    Thick polycarbonate. Injection molded 
Attachment    Highest accuracy at ankle, elasticized strap or cotton Lycra cuff 
Recording Time   Up to 60 days minimum at full resolution 
Resolution    1 minute is standard, user adjustable from 3-180 seconds 
Memory    32KB, includes 64-character user notes field 
Temperature    Operating 0º to 50ºC / Storage: -20º to 70ºC 
Shock / Drop    Survives multiple drops to concrete 
Tamperproof    Permanently sealed 
Waterproof    Yes 
Floats     Yes 
Factory refurbishable  Yes 
FDA     Cleared by the FDA as a class II medical device 

?"#,*'-.%*/+#<"\#=(/H#,-'/6)6/%*6(5>#
Size     106 x 68 x 31 mm 
Weight    150 Grams 
Communication   USB to computer, IR to SAM 
Batteries    Not required 
Power Consumption   100 mA max 
LED status indicators   3 
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StepWatch™ 3.1 Software © 2005 was developed by: 
 

• David Boone and James Beck - Software Development & Programming 
• Kim Coleman - Software Design and Documentation 
• Linda Laing - Quality Assurance Testing, Manual 

 
Funding - Development and improvement of the StepWatch software was funded in part by 
Small Business Innovative Research (SBIR) Grants # R44 HD39036-01 and -02 through the 
National Institute of Child Health and Human Development, a division of the National Center 
for Medical Rehabilitation Research within the National Institutes of Health, USA. 
 
Many of the Orthocare Innovations staff members have worked together in research and 
clinical applications for over a decade. We have brought our multi-faceted experience to the 
StepWatch, attempting to create a powerful tool that is flexible and relevant, yet easy to use.  
 
We know that your needs, applications and computer platforms are extremely diverse. We 
welcome your feedback - positive and negative - as we continue our efforts. 
 
Besides this manual, on-line help is included with your software. Stay tuned to 
www.orthocareinnovations.com for further developments as we continue to improve the 
software and hardware, and tailor services for specific clinical and research applications. Do 
not hesitate to contact us. 
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Orthocare Innovations, LLC 
840 Research Parkway 

Suite 200 
Oklahoma City, OK 73104 

800.672.1710 
For Technical Support: 866.720.0207 

 
 
 
 
 
 
 
 
 
 
 
 

  
EU Representative 
Emergo Europe 
Molenstraat 15,  
2513 BH, The Hague 
The Netherlands 
Phone: +31 70.345.8570 
Fax: +31 70.346.7299 
Contact: Evangeline Loh 
Contact email: Evangeline@emergogroup.com; europe@emergogroup.com 
 
 


